


A Note from Deputy Commissioner, KVS Delhi Region 

It is an established fact that the computer education in school plays an 
important role in overall development of students. Computer with an 
internet access is the most powerful weapon, which opens the doorway of 
all information, knowledge and skill available in this universe. However, 
there was a definite syllabus but in the absence of any study material 
transaction of the computer literacy as a subject was limited to the 
imagination of the teacher. 

With the advent of new era of artificial intelligence, it is need of the time to 
introduce technology and coding at an early stage to students, in a 
uniformed and standard way. In our endeavour to help students become 
better equipped and confident, we have taken the initiative to develop 
syllabi and textbooks which touch all the paradigm of teaching ICT in well 
directed manner. 

This book series for class 3 to 8 has been developed with efforts of many 
teachers and contributions from academicians of KVS Delhi Region. It is 
based on detailed computer literacy syllabus as per CCE(RTE) and all 
applications taught are based on free and open source software. 

The lesson is based on interaction between two students from primary 
classes to encourage auto didacticism and to teach them how to think and 
improve problem solving. We have focused on content and skills to lay a 
strong foundation for learning computers. 

The accomplishment of this venture depends on the cooperation of all 
principals and teachers who will encourage children, guide them and help 
them at different steps and give them infrastructure and proper guidance 
to use this Book. 

Comments on the book and suggestions for next edition are most 
welcome and may be sent to support@kvsrodelhi.in. 

(Nagendra Goyal) 
Deputy Commissioner 



ACKNOWLEDGEMENT 

I hereby acknowledge the contribution and counsel of Smt. Poonam Mallik, 

Assistant Commissioner (KVS Delhi Region) as Chief Coordinator with Content 

Development Team and Sh. Sanjit Kumar, Assistant Commissioner (KVS 

Delhi Region), Smt. Shilbala Singh, Assistant Commissioner (KVS Delhi 

Region) for their regular support and inputs during various meetings. 

I also acknowledge the efforts of Mr. Pravin Kumar, Administrative Officer (KVS 

Delhi Region) and Ms. Shivani Suneja, Finance Officer (KVS Delhi Region) for 

helping in Printing and Publishing. 

I gratefully acknowledge the contribution and determination of Ms Monika Batra, 

Vice Principal, Kendriya Vidyalaya Janakpuri as Regional Coordinator and co-

author and the authors - Ms. Khushboo Aggarwal, PGT CS, KV AGCR, Ms. 

Neelima Singh, PGT CS, KV Sec - 3 Rohini, Ms. Kanchan Khurana, PGT CS, KV 

Sainik Vihar, Mr. Narender Kumar, PGT CS Sec 8 R K Puram in content 

development. 

The contributions of Mr Rajnish (VP), Kendriya Vidyalaya Delhi Cantt No 1 and 
Ms. Ishita, TGT, KV Masid Moth  are acknowledged for reviewing the manuscript

of the series. 

The untiring efforts of Ms Monika Batra, (VP), Kendriya Vidyalaya Janakpuri, 

Mr. Avdhesh Kumar Lawania, PRT, KV JNU, NCERT Br. for formatting, editing, 

compilation and final review is highly acknowledged. 

Finally, with great pleasure, I acknowledge the contribution of Master Ansh 

Kumar, Class XII B (Session - 2020-21), KV Janak Puri for book cover and 

graphics (Gowri and Aryan). 

(Nagendra Goyal) 

Deputy Commissioner 

THIS BOOK, OR ANY PART THEREOF, MAY NOT BE REPRODUCED IN 
ANY FORM WITHOUT THE WRITTEN PERMISSION OF OWNER.



KVS DELHI REGION 2021 

CLASS 6 

TABLE OF CONTENTS 

SL.NO. UNITS 
PAGE 

NUMBER 

1 
PROGRAMMING WHAT AND 

HOW 
1 

2 PYTHON TURTLE 4 

3 ADVANCE IMPRESS 21 

4 LIBRE OFFICE  CALC 30 

5 
FUNDAMENTAL OF 

COMPUTER 
51 

6 ADVANCE WRITER 56 

7 USE OF INTERNET 63 

8 APPENDIX I (ANSWERS) 71 

Copyright Number:- L-100562/2021 Registered With:- KVS Delhi Region



    KVS DELHI REGION 2021 

SYLLABUS
CLASS 6 

Quarter - APRIL  to JUNE 
Sl.No. Units Contents 

1 
Programming 

What and How 
 Programming What and How 

2 Python turtle 

 2.2 Know Python turtle library 

 2.2 Getting started with turtle 

 2.3 Understanding screen and turtle(pen) 

 2.4 

Introduction to programming with turtle 

2.4.1 Directions 

2.4.2 Shortened versions of directions 

2.4.3 Home and quadrants 

 2.5 

Drawing polygons 

2.5.1 Triangle 

2.5.2 Square 

2.5.3 Rectangle 

2.5.4 Star 

 2.6 Drawing circle and dot 

 2.7 
Filling the image with some color and outline 

color 

 2.8 Changing the turtle shape 

 2.9 
Understanding speed of the turtle and 

different parameters in pen function 

 2.10 Cloning the turtle 

11. Small project1

12. Small Project 2

Quarter - July  to September 

3 Advance Impress 

 3.1 Workspace Views 

 3.2 Insert Audio 

 3.3 Insert Video 

 3.4 Grouping / Ungrouping Objects 

 3.5 Working with tables 

4 Libre office  Calc 4.1 

Format Menu: 

4.1.1     Cells 

4.1.2     Rows 

Copyright Number:- L-100562/2021 Registered With:- KVS Delhi Region



    KVS DELHI REGION 2021 

4.1.3    Columns 

4.1.4    Merge Cells 

4.2 

Sheet Menu: 

4.2.1    Insert cells 

4.2.2    Insert rows 

4.2.3    Insert columns 

4.2.4    Delete cells 

4.2.5    Delete rows 

4.2.6    Delete columns 

4.2.7    Insert sheet 

4.2.8    Insert sheet at end 

4.2.9    Insert sheet from file 

4.2.10    Delete sheet 

4.2.11    Clear cells 

4.2.12    Rename sheet 

4.2.13    Hide sheet/Show Sheet 

4.2.14    Move or copy sheet 

4.3 

Data Menu: 

4.3.1    Sort 

4.3.2    Sort ascending 

4.3.3    Sort descending 

4.3.4    Autofilter 

Quarter - October to December 

5 
Fundamental of 

Computer 

 5.1 History of computer 

 5.2 What is computer generation? 

 5.3 Computer Language 

6 Advance Writer 

 6.1 use of templates 

 6.2 

work with objects 

6.2.1    Images 

6.2.2    Shapes 

6.2.3    Formulas 

6.2.4    Page number 

6.2.5    Special characters 

 6.3 formatting shapes 

 6.4 printing a document 

7 Use of Internet 
 7.1 History of Internet 

7.2 Internet and Intranet 

Copyright Number:- L-100562/2021 Registered With:- KVS Delhi Region



    KVS DELHI REGION 2021 

 7.3 Requirement of Internet 

 7.4 Application of internet 

Quarter - January  to March 

7 
Use of the 

Internet (Cont…) 

 7.5 Downloading file from google drive 

 7.6 Uploading file/folder to google Drive 

 7.7 Blog 

Project Projects —in Python 

Copyright Number:- L-100562/2021 Registered With:- KVS Delhi Region



 P a g e  | 1                                            KVS DELHI REGION 2021 
 

1. Programming:-  What and how?? 

Aryan :- It was fun learning scratch last few years. 

Gowri :- Yes, Mam told us that scratch was taught to introduce basic programming 

concepts to us. 

Aryan :- Is it? That was programming. I used to imagine a programming 

as some complex mathematical stuff in English (difficult to understand 

syntax). 

Gowri:- Yes, and you might have pictured a male, who does not speaks 

or interact with anyone and can hack. 

Aryan :- Yes.. Yes 

Gowri :- These all are misconceptions many people have about 

programming or programmers. 

Aryan :- Ok. Is it not all true. 

Gowri :- Not at all. Let me tell you some facts. Firstly, you know that 

who was the first programmer of the world. She was Ada Lovelace, a 

woman. Moreover, Grace Murray Hopper, was a woman who developed 

the first compiler for programming language. 

Aryan :- Oh.. is it. 

Gowri :- And you need not be genius or mathematician to code. If you 

know basic maths and have patience, interest and determinant you can 

code. Rest you know practice makes a person perfect. 

Aryan :- Yes indeed. Thank you for telling me facts. Now I am more 

interested in learning to code. I know now it’s not boring and nerdy. And you told that 

first compiler was developed by a woman. What is a compiler. 

Gowri :- Whatever step by step instructions you give to computer, it is given in an easy 

English like language. But computer understands language of only 0 and 1. That is called 

as binary language. So complier converts our step by step instructions to computer 

language of 0 and 1. 

And now let me tell you what coding is. Coding is instructing computer to do something 

through step by step instructions and to reach a specific outcome. 

Aryan :- As in what we used to do in scratch in script area. 

Gowri :- Yes, That was coding. We can do coding in many languages. Like, I 

talk to you in Hindi or English as you understand these languages. Similarly, 

to give instructions to computer we need to learn its language. Here we will 

be starting with python. 

Aryan :-  Do you have any tips to help me code before I start. 

Gowri :- Yes, First thing is you should be patient and read the question atleast 2-3 

times or more till you are comfortable. Then go through it manually and write down 

the simplified steps in English and thereon you can convert it into programming 

language. You should be willing to make mistakes and not be discouraged by it, as no 

one can code without errors. Not even big programmers.  

For example, if I tell you to make a sandwich. 
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Aryan :- But I do not know how to make it. 

Gowri :- Exactly, so it seems difficult to you. But let me simplify this in step by step 

instructions. 

1. Go to kitchen. 

2. Open fridge.  

3. Take out bread and tomato and cheese slice. 

4. Take one plate and knife. 

5. Wash the tomato and wipe dry. 

6. Cut slices of tomato 

7. Take one slice of bread on plate. 

8. Arrange slices of tomato on the bread slice on plate. 

9. Stack cheese slice on it. 

10. Keep second slice of bread. 

11. Sandwich is ready. 

Aryan :- You made this difficult task so easy by defining in simplified steps. Moreover, 

you were very accurate and even pointed out small details in these steps. 

Gowri :- Yes  Aryan, We have to give all instructions to computer too as if we miss out 

on any we will not get the desired result. Computer do not have its own IQ or 

intelligence to fill gaps if we have in our instructions. It will just do what we tell him 

to. 

Aryan :- Ok, Now I understand.  

Gowri :- Yes, Now before learning to code why do not you write step by step 

instructions for following scenarios. 

 Aryan :- Why not. I can try and I know I can do it because I am determined. 

Gowri :- Good. So scenarios are 

1. Making Maggie noodles. 

2. To find perimeter of top of our book. 

3. To do surya namaskar 

 

Aryan and Gowri looked up videos and questions to improve their problem solving. 

 

Aryan:- Hey Gowri, Its fun to work and I think I can solve many other daily 

problems easily as I can now see things analytically and one day may be I will make 

ROBOT.  

Gowri :- Surely, You can. Infact, one of our 

KVS teacher has made humanoid. Let me 

introduce her to you. 

Shalu is the Indian Artificially Intelligent 

Humanoid Robot developed by Kendriya 

Vidyalaya Computer Science Teacher, Mr. 

Dinesh Kunwar Patel. As per DD News; Shalu 

is the first robot in the world that can 

speak 9 Indian and 38 foreign languages.  
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Figure: Robot Shalu and her creator Mr. Dinesh Kunwar Patel. 

Aryan - I am not sure what humanoid robots are?  

Gowri - Humanoid robots are robots that look and behave just like a human with 

the help of Artificial Intelligence. 

 

Aryan – Does  Shalu understands what we are asking her? 

Gowri – Indeed, Shalu does it with the help of Artificial Intelligence. Shalu can 

listen to our questions and understand what we are asking. She uses the knowledge 

she has collected from the internet to answer our questions verbally, all with the 

help of Artificial Intelligence.  

 

Aryan - Artificial Intelligence? What does that mean? 🤔 

Gowri - Artificial Intelligence (AI) is a technology with which scientists are 

putting human-like intelligence in machines like robots. These intelligent machines 

show behavior similar to a human and can make decisions on their own. 

 

Aryan - So, Shalu is Artificially Intelligent? 😁 

Gowri - Yes!, Shalu can make many decisions on her own, from understanding the 

meaning of asked questions, to finding the correct and suitable answer response. 

Even Mr. Dinesh is unable to predict what she will reply. Her other activities like 

laughing, showing anger and irritation, making jokes just like us, are examples of 

the behavior of artificially intelligent robots. 

 

Aryan - Gowri, I am attracted to Robotics very much. Can you tell me more about 

Robot Shalu? 

Gowri - Of course!. Robot Shalu can recognize people and remember them just like 

us. She is capable to answer many academic questions including math problems too. 

The motive of Mr. Dinesh to develop her is to deploy her as a robot teacher in 

schools to teach us in the class and answer all of our questions. He hopes that 

students will study with interest along with having fun. 

 

Aryan - Oh 🤔, so in the future, only robots will be teaching us? 

Gowri - No dear, you are wrong, Nobody can replace and become the substitute of 

our teachers. Robot Shalu will support the teachers in their work and ease their 

burden in classrooms of delivering lecture-based PowerPoint presentations, taking 

quizzes, etc. 

 

Aryan - Okay! 😄 I am excited about the future when humanoid robots will help us 

and make our day-to-day life easier. 

Gowri - Me too 😄. But better to learn to make one. Now, lets start with Python. 
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2. Python Turtle 

2.1 Know Python turtle library 

2.2 Getting started with turtle 

2.3 Understanding screen and turtle(pen)  

2.4 Introduction to programming with turtle 

2.4.1 Directions 

2.4.2 Shortened versions of directions 

2.4.3 Home and quadrants 

2.5 Drawing polygons 

2.5.1 Triangle 

2.5.2 Square 

2.5.3 Rectangle 

2.5.4 Star 

2.5.5 Hexagon 

2.6 Drawing circle and dot 

2.7 Filling the image with some color and outline 

color 

2.8 Changing the turtle shape 

2.9 Understanding speed of the turtle and 

different parameters in pen function 

2.10 Cloning the turtle 

 

 

2.1 Know Python Turtle Library 

Aryan and Gowri were discussing about different drawing they had made in Tux Paint. 

Gowri:- Hey Aryan .. I really wish to prepare a pattern for myself 

using programming... it will be good to start formulating my 

programming skills..What do you say? 

Aryan :-  Gowri..it will be very difficult..We will need lot of 

time for it..and who knows if it does not work. 

Gowri :- What is there to loose Aryan. Moreover, it does not take much time with 

Python Turtle to make patterns.  

Aryan :- Turtle? As in that we saw in zoo also lives in Computer !!! And you 

are telling it can draw shapes and patterns by moving ..as per my wish?  

Gowri:- I am talking about Turtle, that is, a library in Python ( A programming 

language) not a reptile of zoo, you naïve child. A library is a set of functions that we 

may use in our program to make programming easier. May be you will learn Python 

programs one day if you choose do be a computer programmer in future. Aryan do you 
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know.. Whatever work a computer does for us is due to the coding of the softwares 

by these intelligent people called programmers. 

With Python turtle library we can draw and create shapes and images of our choice. 

For example : 

                         

 

 

 

 

2.2 Getting started with turtle 
 

Gowri:- ..This turtle  that we have seen in zoo  becomes   when it gives 

instructions in computer and it has a big store of ink and colors in its stomach 😊..You 

and our little friends may find it already present in your computers if you have Python 

3.0 ( programming language ) or later version installed  or simply download Python from 

https://python.org/download  

Aryan :- How do we start working on it ? 

Gowri:- Open the site I just told above.. and download Python if you don’t have. Open 

Python IDLE then turtle gets ready to listen to your instructions. 

 

Fig. 2.1 Python IDLE Screen on Starting 

This is the actual screen where I need to write my instructions. Click on file and then 

select new file.  
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2.4 Introduction to programming with turtle  

Gowri:- if I ask you to draw a line in notebook what do you do? 

Aryan :- Hey  ..It is not funny I know..I will take a blank paper 

and a pen..then make a line in any direction ..as simple as that..  

Gowri :- Wow.. it really is as simple as that..See I show you ..the 

CANVAS/SCREEN  is your paper..turtle pen is your onscreen pen..commands that you 

will give will make the line  

Now when I say turtle it means the PEN. The turtle can move up or down , but when 

it moves up or down it just moves..no line is drawn.. Now let us understand the 

directions first. 

2.4.1 Understanding directions 

Gowri :- There are four directions that a turtle can move in : 

 Forward 

 Backward 

 Left 

 Right 

The turtle moves in Forward or Backward direction that it is facing. You may 

change the direction by using Left or Right to an angle degree. 

 

Fig 2.3  

Please look at this direction fig and you will understand how to go about it. 

Now let us see one simple example: 

If you type these lines as program code: 
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Then we get :  

Gowri:- I told the turtle to move 100 points(pixels) in the direction it was facing 

so it drew first line... 

Now I explain how you move and change direction using turtle on drawing board 

i.e. Canvas.. 

● Turtle.forward(n) – To move the turtle forward by given points 

e.g. turtle.forward(100) 

● Turtle.backward(n) – To move the turtle backward by given points 

e.g. turtle.backward(100) 

● Turtle. left(degree) – To change the direction of turtle to left by given 

angle degree 

e.g. turtle.Left (90) 

● Turtle. right(degree) – To change the direction of turtle to right by given 

angle degree  

e.g. turtle.Right (90) 

 

2.4.2 Shortened versions of directions: 
 Aryan:- Do I need to right forward/backward/left/right only whenever I need 

to make a shape or is there any shortcut way too?? 

Gowri:- Ohh..Sorry I forgot to tell you.. you may use following shortened forms of 

the above commands.. they will produce the same result.. 
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● T.fd(n) – instead of turtle.forward(n) 

e.g. t.fd(100) 

● T.bk(n) – instead of turtle.backward(n) 

e.g. t.bk(100) 

● T.lt(degree) – instead of turtle.left(degree) 

e.g. t.lt(90) 

● T.rt(degree) – instead of turtle.right(degree) 

e.g. t.rt(90) 

 

Gowri:- You now can write your codes using any of the methods that you like .. 

2.4.3 Home and quadrants: 
 Aryan:- I want to learn the figure about quadrants in detail ..please help. 

Gowri:- (0,0) is the starting position of the turtle when you open the Python Turtle 

software. It is also known as home position.  

From the fig. 2.3 we see that there are four quadrants ..means four parts ..x means 

horizontal and y means vertical ..If we move up then y increases and if we move down 

then y decreases. Similarly if we move right x increases and if we move left y 

decreases. This is in relation to Home position of the turtle. 

2.5 Drawing Polygons: 
A command tells the turtle to do exactly what we want, so it is an instruction.   

Aryan:- .. I have understood the commands for moving the turtle and changing 

directions.. I can show you by drawing various geometrical figures.. shall I? 

Gowri:- Yes dear ..go ahead and show me please.. 

2.5.1 Drawing a Triangle: 

 

Aryan:- Look  Gowri..I wrote pen. forward(100) to move the pen 100 points in forward 

directions of turtle, then I changed its face towards left by 120 degree then moved 

forward again by 100 points then turned again to left by 120 degrees and then forward 

by 100 points and I was able to draw the triangle in one go.. Wow.. I am happy I made 

my first complete figure.. triangle.. 
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Gowri:- Great Aryan.. Looks Kooool..  

Aryan:- Thanks  Gowri for introducing me to coding.. You are my very own 

Turtle Code Jr. Teacher  

2.5.2 Drawing a Square  

 Aryan:- I can draw a simple square also by using these commands , please let me 

continue.. 

 

Gowri:- I think you are becoming quite an expert Aryan. I am happy for you..Yeah 

it is right ..We just need to change the direction at 90 degree and move 100 

pixels forward ..for as many times as the sides of a square.. forward will have the 

same value each time as sides of a square are equal..great going ..  

 Aryan:- I could see the turtle actually start and move in the given direction 

and then making a complete square..it was fun..  

2.5.3 Drawing a Rectangle: 

Gowri:- can you try drawing a rectangle now.. think what changes do we need to do 

in the code of square..I am giving you a hint: 

Opposite sides of a rectangle are equal and all sides are not equal…Come on..Tickle 

your brain cells..You can do it.. 

Aryan :-OK  ..Let me think and try.. 

 

 I did it… I just worked on the hint that you gave..  
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2.5.4 Drawing a Star: 

Gowri:- ..for all the hard work and shapes that you have drawn so far , I want to 

give you a star..Here comes your STAR student: 

 

Now..just observe the angle and I have used the same commands  

2.5.5 Drawing a Hexagon: 

Aryan:- OK.. I got it  Gowri..I understood how you changed the angles to make 

this star..I can make a hexagon also by using this concept..please let me do.. 

Gowri:- Sure Aryan..go ahead and create whatever you want if you understood it 

well you will be able to make one without any problems.. 

Aryan:- I did it .. I did it.. I am so happy .. I am learning without any problem.. 

Initially I thought coding will be tough but actually it is not if you understand the 

concept well..Look at my code and hexagon that I created.. 

 

Gowri:- Instead of writing it in repetition for 6 times ..you may use a for loop..It is 

used for repetitive execution of code means if you need to write some commands 

again and again , you may put those commands in a for loop. 

 E.g. for i in range(6): 
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 pen.forward(100) 

 pen.left(6) 

 It will also produce the same result of making the hexagon 

 range(n)  is a library function which takes a no. which actually means the total 

steps for which a command/commands are to be repeated. When I gave 6 it 

means total six steps/times ( starting from 0 to 5, both inclusive) 

2.6 Drawing circle and dot: 

We can also draw circle in Python turtle by using turtle.circle(r) ,here r means the 

radius of the circle. radius is taken as the total pixels/points starting from home 

position of the turtle. 

Gowri:- Would you like to make a circle with radius 50 points.. 

Aryan:- OK ..I will.. 

 

Look  Gowri..I am done with this shape too  

Gowri :- You can create a filled circle by just changing circle with dot..e.g. 

turtle.dot(50)..It will look something like this: 
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As simple as that..  

 You may increase/decrease the size of circle/dot by changing the radius. 

 A dot is nothing but a filled-in circle 

 Unlike circle the no. within function dot is DIAMETER of the circle 

Great work so far!! You have learnt to make basic shapes with your turtle pen on your 

canvas. Now let us add more fun to this coding thing.. I will now tell you how you may 

change the outline/pen colour and fill your shape with colour of your choice.. 

2.7 Filling the image with some colour and outline colour: 

By default, when you open the turtle the background screen is of white colour , we 

can change the background of the screen or drawing board as you have understood 

by using: 

Turtle.bgcolor(“name of the colour”) 

e.g. turtle.bgcolor(“green”) 

To change the outline colour of the shape we can use : 

pen.color(“name of the colour”) 

e.g. turtle.pencolor(“red”) 

 

Gowri:- see I have changed the background colour to green and pen colour of the 

shape to red.  

Look at the code carefully and you will know how I did it.. 
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You can use pen .begin_fill() before drawing a closed figure and close it by 

pen.end_fill() after drawing the figure ..It creates a shape by filling it with solid 

colour. You have to give colour of your choice after begin_fill() 

 

Pen.fillcolor(“name of the colour”) can be used to give the color for filling in the closed 

shape. 

See the above figure ..I have used begin_fill(), fillcolor(), end_fill() and the shape i.e. 

circle() 

The code has given me a circle filled  with yellow color having red outline and blue 

background of canvas. 

2.8 Changing the turtle shape: 

 Aryan:- I thought pen turtle will be like a real turtle animal in looks but it is 

actually  an arrow in shape.. 

Gowri:- I have one more surprise for you here..Yes you guessed it right ..You can have 

the shape of pen as real turtle .. 

 

Is it not something that you were imagining?? 
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You can change the pen turtle to these shapes of your choice: 

✔ turtle 

✔ arrow 

✔ circle 

✔ square  

✔ triangle 

 

by using turtle.shape(“shape name”) 

e.g. In above program name of my turtle(pen) is pen so I have used 

pen.shape(“turtle”) 

 Original shape of the turtle is referred to as classic , so to get back the 

original shape we may use : 

o turtle.shape(“classic”) 

2.9 Understanding speed of the turtle and different parameters in 

pen function: 

Let me tell you something more interesting.. the turtle pen speed can also be 

changed if you think it is moving slow/fast.. 

  Turtle.speed(n) – To increase/decrease the speed of the turtle while drawing 

The n given in bracket can be any number between 0 and 10 where 0 means the 

slowest speed and 10 means the highest speed. 

Gowri:-Try this code and feel the difference in speed of the turtle. 

import turtle 

Scr = turtle.Screen()  

pen = turtle.Turtle() 

pen.shape("turtle") 

pen.speed(1) 

pen.fd(100) 

pen.rt(90) 

pen.speed(5) 

pen.fd(100) 

pen.rt(90) 

pen.speed(10) 

pen.fd(100) 
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Hope you found it interesting..? 

Aryan:- Well… I think by now you have become familiar with most of the working of 

the turtle environment, canvas, pen and drawing shapes ..filling them with any color 

etc. So , let me ask you something : 

Suppose you want to do following with your turtle: 

 Change pen color to red 

 Change fill color to green 

 Change pen size to 10 (width of outline) 

 Change pen speed to 4 

Gowri:- Can you write the code??  

Aryan:- Yes..I can.. It will be : 

Turtle.pencolor(“red”) 

Turtle.fillcolor(“green”) 

Turtle.pensize(10) 

Turtle.speed(4) 

Am  I correct?? 

Gowri:- Yes..but you can use just one line of code instead of these all ..by using 

Turtle.pen(pencolor=”red”, fillcolor=”green”, pensize=10, speed=4) 

Aryan:- Sorry  ..I am not able to understand it.. 

Gowri:- No issues..I will give an example to make things more clear to you.. 

 

 

Observe the pen size and other things that are written in bracket and compare them 

with the result that is here..It is very easy to do. 
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2.10 Cloning the turtle: 

We can create clone ( similar copy ) of a turtle by using clone() function – it creates 

an exactly same copy of the pen at the same position. It can be used when we want 

to have two or more copies of the turtle on the same drawing screen. 

e.g. in the above example pen is our turtle, If I need to have another turtle by the 

name pen1 then I can use 

pen1=pen.clone() 

We can use two or more clones of the turtle with different colors to create 

beautiful patterns ..let me show you how: 

 

In this example I have created first turtle by naming it pen1 and pencolor as red, then 

I cloned it in pen2 (another turtle is created) and changed its pencolor to blue. While 

drawing the circles with both I just changed the radius and see I have got a beautiful 

pattern.. 
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SMALL PROJECT 1: 

✔ We can use the pen() function with different parameters for creating 

pen1 with some size and fillcolor and some other for pen2/pen3  

  

This is the beautiful pattern can be created by three different turtles created 

using cloning and then changing their pen and fill colors. 

SMALL PROJECT 2: 
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Exercise 

Something to Know 

A.  Answer the following questions: 

1. What do you mean by term Canvas of Python turtle graphics? 

2. Why do we use turtle? 

3. Why do you require to set up Python turtle screen? 

4. What is home position? How many quadrants are there in python turtle screen? 

5. How do you change the direction of turtle? 

 

B. Fill in the blanks: 

1. There are …………………… quadrants in Python turtle.  

2. A ……………………..is a set of instructions to make a shape. 

3. pen.fd(100) will move the turtle 100  …………………. In forward direction. 

4. ……………………. Is the default shape of turtle. 

5. ……………. and ………………….. are used to turn the face of the turtle. 

  

C. Match the following: 

A B 

a. Canvas is 1. Home 

b. import  2.  Used for giving different parameters for defining 

the behaviour of pen  

c. The default position of turtle  3.   Used for repetitively running the commands 

d. Pen1.pen()  4.  Python turtle drawing area 

e. for  5. Used for including Python turtle library for using the 

functions of turtle 

  

D. Select the correct answer for each question: 

1. pen.circle(n) has n as : 

a. side  b. radius     c. diameter      d. None  

 2. Which of the following is not a valid command in turtle graphics? 

a. fd()       b. bd()      c.   lt()       d. rt() 

 3. You can use pen.dot(n) for drawing a ? 

a. dot   b. filled circle    c. circle     d. none of these 

 4. pen.clone() is used to - 

a. create a different pen   b. define a pen     c. copy a pen     d. both a and c 

 5.What is the highest value we can give in pen.speed()? 

a. 4      b. 1      c. 10     d. 5 

 E. State True or False.  

1. By default face of the turtle is downwards. 

2. We can define more than one turtle on a screen of turtle graphics. 
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3. We cannot change the outline color of pen. 

4. We can fill the shape with any color of our choice. 

5. pen.forward(100) is same as pen.fd(100).    

  

Something to Do: 
1.   We can position the turtle to any x,y location. Use the following command to go to any 

coordinate wrt home. 

>>>turtle.goto(x,y) 

    e.g. turtle.goto(10,20) 

2.   Turtle.up() can be used to stop all drawing on the screen, cursor can still be placed at 

any location. Drawing will resume when you call turtle.down() again 

Turtle.clear() can be used to clear the entire screen area. Try it as the last command. 
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Grouping: To make objects treated like a single object so that they can be move, 

resize or rotate simultaneously. To make group of multiple objects steps are 

following. 

 Select all shapes or objects you want to group. To select all shapes at once 

follow any of following 

 press Ctrl+A   

 on standard toolbar click edit -> select all  

 select any of the shape. Hold shift key on keyboard and continue to click 

on another shapes. All get selected on click. 

 Click format -> Group -> Group  or press Ctrl+Shift+G 

 All shapes are grouped together. Now you can apply select, move, resize, rotate 

over all shapes. 

 

Fig 3.10 

           
              Fig 3.11    Fig 3.12        Fig 3.13 

 All effects get applied over all shapes simultaneously. 

To ungroup shapes, click format-> Group -> Ungroup or Ctrl+Alt+Shift+G. All shapes 

get separated from each other.  

 Try Now- Apply Cut, Copy, paste over grouped shapes and observe. Are you successful? 
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Insert/Delete Row & Column: Keep cursor on required cell and click right mouse 

button. Options ger appeared as shown in fig 3.15 and 3.16. 

   

   Fig 3.15           Fig 3.16 

Merge / Split Cells: You can merge two or more column /rows. Same way merged 

cells can be split. 

Table properties: To set font size, styles, colours of text of table, to set 

background and borders of table, click on right mouse button->table properties. 

 
Fig 3.17 

 

 

 

Try Now- Observe the difference between automatic slide move and a mouse click 

move. Which one you find better?  
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Let us revise we have learnt: 

 Normal, Outline, Notes and Slide sorter are the workspace views available to 

review slides. 

 Audio and Video are the best way a student can present his / her views in form 

of presentation.  

 Insert -> Audio or Video -> choose file. So easy.  

 Grouping makes multiple images to treated as single image and make it possible 

to rotate, resize, move them together. 

 A table in which data is managed using rows and columns. Use Insert-> table. 

 All table related operations like styles, background, borders, font, inserting 

rows columns, deleting are available in impress. 

EXERCISE 

SOMETHING TO KNOW 

A. Answer the following questions. 

1. Gowri prepares a presentation on ‘Woman empowerment’ and have to present in 

annual function of her school. But she is very nervous because she is missing 

some points of details regarding topics she has included in her presentation. 

Can you suggest the option in Impress to keep these points along with slides?       

2. What is the difference between Slide pane and Slide sorter view? 

3. Write steps to insert a Video in your slide?  

4. Aryan took a presentation from his friend. In one slide there were two images 

of their school. He needs one of the images. When he tried to copy one image, 

he was surprised that both were get selected by clicking on any of the image. 

He was not able to select the single pic. Help him in doing so. 

5. Write any two options available in table properties. 

B. Fill in the Blanks. 

i. A column can be inserted either ____ or ____ of selected column.  

ii. Ctrl+Shift+Alt+G is used to __________ the objects. 

iii. Merged cells can be _______ in to original form. (Split/copied) 

iv. By default view of slides are ________ View. 

v. Audio inserted in the slide can be listen in __________. 

C. Match the following 

a) Audience cannot see p) Tables 

b) Gradient is a part of q) applied over text in table 

c) holding shift key and clicking on shapes r) Background of table 

d) Best way to represent time table of anything  s) Notes in slide 

e) Font effects in table properties t) select all shapes together 
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4. LIBREOFFICE CALC 

4.1 Format Menu: 

4.1.1 Cells 

4.1.2 Rows 

4.1.3 Columns 

4.1.4 Merge Cells 

4.2 Sheet Menu: 

4.2.1 Insert cells 

4.2.2 Insert rows 

4.2.3 Insert columns 

4.2.4 Delete cells 

4.2.5 Delete rows 

4.2.6 Delete columns 

4.2.7 Insert sheet 

4.2.8 Insert sheet at end 

4.2.9 Insert sheet from file 

4.2.10 Delete sheet 

4.2.11 Clear cells 

4.2.12 Rename sheet 

4.2.13 Hide sheet/Show Sheet 

4.2.14 Move or copy sheet 

4.3 Data Menu: 

4.3.1 Sort 

4.3.2 Autofilter 
 

Aryan :- Remember Gowri, We made table of foods liked by our 

classmates. 

Gowri :- I do remember Aryan and we used options from View, insert and Format 

menu for various tasks.  

Aryan :- yes Gowri, But what if I forgot to enter a name. Can I add a name in 

between the table. 

Gowri :- Yes, you can add row and column in a table anywhere. You 

may also increase or decrease row/column width. We have 

different menus for that. Let me explain them to you.  

4.1 Format Menu 

The Format Menu is the fifth menu located on menu Bar. It has various options 

associated with it. It has various submenus associated with it. It has options to 

format cells, rows and columns. 
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4.1.1 Cells 

We can do formatting of cells from this option:- 

1. Select the Submenu Cells 

2. Format-> Cells 

3. In the figure given below, you can see that cells can be formatted. 

4.  The shortcut key is Ctrl+1. 

 

     Fig 4.1 

4.1.2 Rows 

To change the height of the rows following are the steps :- 

1. Select the Submenu Rows 

2. Format-> Rows 

3. In the figure given below, you can see that rows can be formatted. 

4. The height of row can be changed. 

5. The rows can be hidden or displayed. 

We can also hide or show row from here. 
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     Fig 4.2 

4.1.3 Columns 

 This option can be used to change width of the columns.  

1. Select the Submenu Columns 

2. Format-> Columns 

3. In the figure given below, you can see that columns can be formatted. 

4. The width of column can be changed. 

5. The columns can be hidden or displayed. 

 

Fig 4.3 
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4.1.4 Merge Cells 

 Aryan was writing heading for his table. He wanted heading to cover more than one 

cell.   

Gowri:- If you want any data to cover more than one cell, we use merge option 

1. Firstly, select the cells you want to merge.  

2. Select the Submenu merge Cells. 

3. Format-> Merge Cells 

4. In the figure given below, you can see that cells can be 

merged. 

5. The other method is to select the button on formatting toolbar. 

 

Fig 4.4 

 Aryan :- What if we miss on any column or row. Do we need to again make a new 

table. 

Gowri :- No, we have option to add or delete any row or column or single cell in Sheet 

Menu. 

4.2 Sheet Menu 

4.2.1 Insert cells 

1. Select the Submenu Insert cells 

2. Sheet-> Insert cells 

3. In the figure given below, you can see that cells can be inserted. 

4. The shortcut key to insert cells is Ctrl++ 
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Fig 4.5 

4.2.2 Insert rows 

1. Select the Submenu Insert rows. 

2. Sheet-> Insert rows 

3. In the figure given below, you can see that rows can be inserted in a 

spreadsheet. 

 

Fig 4.6 

Copyright Number:- L-100562/2021 Registered With:- KVS Delhi Region



 P a g e  | 35                                            KVS DELHI REGION 2021 
 

4.2.3 Insert columns 

1. Select the Submenu Insert columns. 

2. Sheet-> Insert columns. 

3. In the figure given below, you can see that columns can be inserted in a 

spreadsheet. 

 

Fig 4.7 

4.2.4 Delete cells 

1. Select the cells you want to delete. 

2. Select the Submenu Delete cells 

3. Sheet-> Delete cells 

4. In the figure given below, you can see that cells can be deleted. 

5. The shortcut key to insert cells is Ctrl+-. 

 

Fig 4.8 
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4.2.5 Delete rows 

1. Select the rows you want to delete. 

2. Select the Submenu Delete rows 

3. Sheet-> Delete rows 

4. In the figure given below, you can see that rows can be deleted in a 

spreadsheet. 

 

Fig 4.9 

4.2.6 Delete columns 

1. Select the columns you want to delete. 

2. Select the Submenu Delete columns 

3. Sheet-> Delete columns 

4. In the figure given below, you can see that columns can be deleted in a 

spreadsheet. 

 

Fig 4.10 
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4.2.7 Insert sheet 

You may also add a new sheet in calc. 

1. Select the Submenu insert sheet 

2. Sheet-> Insert sheet 

3. In the fig. 4.11, you can see that a sheet can be inserted. 

4. As shown in fig 4.12, a dialog box to insert sheet appears. 

5. Here sheet can be inserted before or after current sheet. 

6. In this dialog box, you can specify the number of sheets you want to insert as 

well as the name of the sheet. 

7. The alternate way is to right click on the insert sheet tab in the bottom of 

the spreadsheet and same dialog box appears. 

 

Fig 4.11 

 

Fig 4.12 
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4.2.8 Insert sheet at the end 

1. Select the Submenu insert sheet at the end 

2. Sheet-> Insert sheet at the end 

3. In the fig. 4.13, you can see that a sheet can be inserted at the end. 

4. As shown in fig 4.14, a dialog box to append sheet appears. 

5. Here sheet can be inserted at the end. 

6. The alternate way is to right click on the insert sheet tab in the bottom of 

the spreadsheet and same dialog box appears. 

 

Fig 4.13 

Fig 4.14 
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4.2.9 Insert sheet from file 

Steps to add an already existing sheet from another file to your file. 

1. Select the Submenu insert sheet from file 

2. Sheet-> Insert sheet from file. 

3. In the fig. 4.15, you can see that a dialog box appears. 

4. After that a dialog box to insert sheet from another file appears. 

5. Then sheet to be inserted is selected. 

6. The alternate way is to right click on the sheet tab in the bottom of the 

spreadsheet and same dialog box appears. 

 

Fig 4.15 

4.2.10 Delete sheet 

1. Select the Submenu delete sheet from file 

2. Sheet-> Delete sheet. 

3. In the fig. 4.16, you can see the option to delete sheet. 

4. After that a dialog box to delete sheet appears, as shown in fig. 4.17. 

5. Then current sheet is deleted. 

6. The alternate way is to right click on the sheet tab in the bottom of the 

spreadsheet, select delete sheet option from there and same dialog box 

appears. 
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Fig 4.16 

 

Fig 4.17 
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4.2.11 Clear cells 

Steps to clear the cells on which you were working.  

1. Select the Submenu clear cells 

2. Sheet-> Clear cells. 

3. In the fig. 4.18, you can see the option to clear cells. 

4. After that a dialog box to clear cells appears, as shown in fig. 4.19. 

5. Then current cells are cleared. 

6. The shortcut key to clear cells is Backspace. 

 

Fig 4.18 

 

Fig 4.19 
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4.2.12 Rename sheet 

 Aryan :- I want to rename the current sheet on which I am working.  

Gowri:-  Yes, Its better to give meaningful name to sheet so as we know 

what type of data is in it. You can do it by following the 

steps below: 

1. Select the Submenu Rename sheet from file 

2. Sheet-> Rename sheet. 

3. In the fig. 4.20, you can see an option to rename sheet. 

4. After that a dialog box to rename sheet appears, as shown in fig. 4.21. 

5. Then current sheet is renamed. 

6. The alternate way is to right click on the sheet tab in the bottom of the 

spreadsheet, select rename sheet option from there and same dialog box 

appears. 

 

 

Fig 4.20 
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Fig 4.21 

 

4.2.13 Hide sheet/ Show Sheet 

It is also possible to hide the current sheet on which you are working.  

1. Select the Submenu Hide sheet. 

2. Sheet-> Hide sheet. 

3. In the fig. 4.22, you can see an option to hide sheet. 

4. Then current sheet is hidden. 

5. In the fig. 4.23, you can see an option to show sheet and a dialog box occurs 

to show hidden sheet. 

6. The alternate way is to right click on the sheet tab in the bottom of the 

spreadsheet, select hide sheet/show sheet option from there and same dialog 

box appears. 
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Fig 4.22 

 

Fig 4.23 
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4.2.14 Move or copy sheet 

Steps to move or copy the current sheet 

1. Select the Submenu Move or Copy sheet. 

2. Sheet-> Move or Copy sheet. 

3. In the fig. 4.24, you can see an option to Move or Copy sheet. 

4. Then current sheet can be moved or copied. 

5. In the fig. 4.25, you can see an option to move or copy sheet and a dialog box 

occurs to move or copy sheet. 

6. The alternate way is to right click on the sheet tab in the bottom of the 

spreadsheet, select move or copy sheet option from there and same dialog box 

appears. 

 

Fig 4.24 

 

Fig 4.25 
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4.3 Data Menu 
Data menu has certain options such as sorting in ascending or descending order and 

AutoFilter etc.  

4.3.1 Sort 

 Aryan :- Can I arrange the data in table in alphabetical order of name..  

Gowri :- yes, you can arrange it in any order by any column. 

1. Select the Submenu Sort. 

2. Data-> Sort. 

3. In the fig. 4.26, you can see an option to sort the data. 

4. Then select the option to sort the data. 

5. In the fig. 4.27, you can see dialog box to sort the data. 

 

Fig 4.26 

 

Fig 4.27 
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Sort ascending 

1. Select the Submenu Sort ascending. 

2. Data-> Sort ascending. 

3. In the fig. 4.28, you can see an option to sort the data in ascending order. 

4. Then select the option to sort the data in ascending order. 

5. Then data is sorted in ascending order. 

 

Fig 4.28 

 

Sort descending 

1. Select the Submenu Sort descending. 

2. Data-> Sort descending. 

3. In the fig. 4.29, you can see an option to sort the data in descending order. 

4. Then select the option to sort the data in descending order. 

5. Then data is sorted in descending order. 
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Fig 4.29 

4.3.2 AutoFilter 

 Aryan:- I want to display records of students who like pizza and pasta 

Gowri :- You can put filters on the data by selecting the Submenu AutoFilter to view 

some selected data. It then hides other data. 

1. Data-> AutoFilter. 

2. In the fig. 4.30, you can see an option to apply filter on the data. 

3. Then select the option to auto filter the data. 

4. Then filter is applied on all fields as shown in Fig 4.31. Then few records/rows 

can be selected based on a certain criterion. 

 Aryan selected pasta and pizza from drop down of liked food item cell. 

 

Fig 4.30 
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Fig 4.31 

Exercise 

Something To Know 
Q I.  State True or false: 

1. The Sort option is in Insert menu. 

2. The AutoFilter option is in Data menu. 

3. The shortcut key to clear cells is Backspace. 

4. The rename sheet is in Data Menu. 

5. Sorting on data can be done in ascending or descending order. 

 

Q II. Match the following:- 

Column A    Column B 

1. Format cells    Sort 

2. Insert cells    Ctrl+- 

3. clear cells    Ctrl+1 

4. Delete cells    Backspace 

5. Data     Ctrl++ 
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Q III. Fill in the blanks:- 

1. The ____________ ascending feature is used to arrange data in ascending 

order 

2. The _____________feature is used select rows based on a specific criteria. 

3. The ______________ feature is used to display hidden sheet. 

4. The insert rows option is present in ____________ menu. 

5. The merge cells option is present in ____________ menu. 

QIV. Answer the questions based on CCT: - 

1. A wants to see only specific rows based on a condition in the spreadsheet. 

Which feature of LibreOffice Calc is required to do this task? 

2. B wants to sort the data in descending order of marks so that first three 

toppers come on top in a spreadsheet. Which feature of LibreOffice Calc will 

be used by him? 

3. A wants to combine cells of data given in a spreadsheet. Which feature of 

LibreOffice Calc will be used by her to do it? 

4. B wants to insert a new sheet in the end of the existing spreadsheet. Write 

the steps to do it? 

5. Name the menu which has the option to change row height and column width. 
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5. FUNDAMENTAL OF COMPUTER 
 

5.1 HISTORY OF COMPUTER 

5.2 COMPUTER GENERATIONS 

5.3 COMPUTER LANGUAGES 

 

GOWRI:-  Aryan.. What are you thinking so deeply. 

ARYAN: Hello Gowri,I was thinking that this computer that we are 

working on. How did it develop? Was it always like this? 

GOWRI: No  Aryan. Let me tell you about the HISTORY OF 

COMPUTERS. The computer you see today was not like this before. It took 

many years to make the computer as it is today. Let us look at the history and 

generations of the computers. 

ARYAN:  Really, I am eager to know ?  

GOWRI:  Ok , today I will tell you about the History of computers 

In the starting fingers, toes, stones, sticks were used for counting. Then it 

became difficult to do bigger and complex calculations. 

5.1 History of computers  
 ABACUS:     So, first calculating device ABACUS was 

invented about 5000 years ago by Chinese to do simple 

addition and subtraction.  

Fig. 5.1 

 NAPIER’S BONES: In 1617, John Napier invented 

calculating device NAPIER’S BONES. It was meant for 

simple calculations like addition, subtraction, 

multiplication. Later on, it was improved to perform 

division and to find square root. 

Fig. 5.2 

 PASCALINE: In 1642, Blaise Pascal a French 

mathematician invented the first mechanical 

computing machine known as PASCALINE. It 

consisted of a box with movable gears.   

                    Fig. 5.3  
 

 STEP RECKONER: In 1692, the more advanced calculating machine named STEP 

RECKONER was developed by Gottfried Wilhelm(von) Leibniz. It can do 

addition, subtraction, multiplication and division.     

                 

 BABBAGE’S ANALYTICAL ENGINE : In 1833, a mathematics professor of 

Cambridge University, England, CHARLES BABBAGE developed Analytical 

Engine. It has five key features: Input, storage, processor, control unit and 

output.  
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CHARLES BABBAGE is known as father of computer. Because all these 

features are found in today’s computers. 

 

 TABULATING MACHINE: In 1890, an army engineer known as Herman 

Hollerith invented a tabulating machine. Actually it was used in census of the 

USA. And after success of Tabulating Machine that company later became very 

famous as IBM.                                       

                          

MARK-1: In 1944, Prof. Howard Aiken invented 

the first electro-mechanical computer named as 

MARK-1. 

             Fig 5.7 

 

 ENIAC and UNIVAC: ENIAC was the first successful Electronic digital 

computer built by John Mauchly and John Presper Eckert in 1946.  
 

 
Fig 5.8 

 

 

 UNIVAC: And in 1951, 

they developed another 

computer UNIVAC which could 

handle both numeric and 

textual information. 

 

 

 

Fig 5.9 

 Personal computer: In 1981, IBM 

introduced first personal Computer 

(PC).And in 1984,Apple introduced 

Macintosh. 

 

      

 

                                              Fig. 5.10 
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 ARYAN:  Interesting, so in this way we reached to what we are 

having today “Personal Computer”. You have not told me full form of 

ENIAC AND UNIVAC. 

GOWRI: Oh sorry,I forgot. The full form is:  

ENIAC: Electronic Numerical Integrator And Computer . 

UNIVAC: Universal Automatic Computer. 

 

ARYAN: Thank you so much for this information, What we are going to learn 

next? 

GOWRI: Next we are going to learn about Generations of computers. 

ARYAN: Generations???Do computer also have generations. 

GOWRI: Yes, as we all have generations in our family like grandparents, parents 

and children. Computer also has its different generations. In computer a Generation 

means remarkable growth and development in computer technology. 
 

5.2 Generations of computers 
ARYAN:  I am excited to know about these generations. 

GOWRI: Let us discuss it in detail with the help of following table. 

 There are five generations of computers: 

Table 1.1 

Generation  Period  Technology Example  

FIRST 

GENERATION 

Started in 1946. 1.Vaccum tube 

2.They use machine language 

ENIAC, 

UNIVAC 

SECOND 

GENERATION 

In late 1950s 1.They use Transistors 

2.They used Assembly language 

IBM140,MA

RK III 

THIRD 

GENERATION 

In mid 1960s 1.They used Integrated Circuits. 

2.They used High level languages 

like Fortran,Cobol 

IBM-360, 

CDC 

FOURTH 

GENERATION 

 

 

 

Started in 1971 2. They used Microprocessor 

3. They used high-level languages 

like C,C++ ,java. 

4. Internet was developed in 

fourth generation. 

IBM 370, 

Intel 4004 

FIFTH 

GENERATION 

STILL IN 

DEVELOPMENT 

1. They use super large scale 

integrated chips. 

2. They are intended to work with 

natural language. 

3. They will have Artificial 

Intelligence(AI) 

Robots  
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C. Match the Following. 

 

D. State True  or  False  

1. Earlier bones ,stones were used for calculation.            

2. Fourth generation computers use vaccum tubes. 

3. MARK-I was first electro-mechanical computer. 

4. UNIVAC was developed in 1942. 

5. Charles Babbage developed Analytical engine. 

 

SOMETHING TO DO 

Make following table in your notebook and write Inventors and year. 

 INVENTORS YEAR 

Pascaline   

Analytical    

MARK-1   

ENIAC   

TABULATING 

MACHINE 

  

ABACUS   

STEP RECKONER   

  

1. Macintosh a) UNIVAC 

2. Cobol b) Apple 

3. Herman Hollerith   c) Robots 

4. Atrificial Intelligence d) High level language 

5. Vaccum Tubes e) Tabulating Machine 
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6. ADVANCE WRITER 

 6.1 Use of Templates 

 6.2 Work with Objects 

 6.2.1 Images 

 6.2.2 Shapes 

 6.2.3 Formulas 

 6.2.4 Page numbers 

 6.2.5 Special characters 

 6.3 Formatting Shapes and images 

 6.4 Printing a document 

 

6.1 USE OF TEMPLATE 

 

   

Template is the file which have pre-

defined formats of documents. These serve as a starting point to work in workspace. 

We can use these formats either as it is or can update as per our need. 

 

Fig 6.1 

Do you remember 

templates? 

Yes, We did them in 

impress. They are 

built in formats 

You are right, but in writer we do it 

differently. Let me tell me explain. 
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      Resize                Rotate                  Move  

      Fig 6.6                        Fig 6.7         Fig 6.8 

Steps are as following: 

I. Insert the required image or shape in your document. 

II. Select the image / shape. Selection handle gets appeared. 

III. Put the cursor on appropriate selection handle and apply the required 

formatting as shown in above fig 6.6, 6.7, 6.8. 

 

 

 

6.4 PRINTING A DOCUMEMT 

You can print the document you have 

prepared along with all the objects you have 

used in your documents like images, shapes, 

text etc. 

To print a document steps are as following. 

Click on File -> Print option or press Ctrl + P. 

i. A dialogue box gets appeared as 

shown in fig 6.9.  

ii. Select the printer attached with 

your system.  

iii. Select other options like page 

numbers, no of copies 

iv. After all settings click print. You 

will get the hard copy of your 

document. 

v.  icon on the standard toolbar 

will help you to take print of all 

pages of your document directly 

without going for any settings. 

 

 
Fig 6.9 

Try Now- Are the selection handles during selection of image and during rotation 

remains same? Observe. 

Now, you are ready to 

print your document. 
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Let us Revise: 

 Templates are the sample fill in the blank documents which can be updated. 

 Images can be inserted from any file. 

 Shapes are pre-defined in writer. 

 Formulas are used to make mathematical and scientific expressions. 

 Page numbers are used to insert page no in current page at cursor location. 

 Special characters provide various symbols. 

 An image and shape can be resized, rotate, moved. 

 Ctrl+P is the shortcut to print a document. 

Exercise 

Something to know 
A. Answer the following questions. 

1. Write any two advantages of template?  

2. Aryan inserted the following image in her document. She 

felt it is not in proper view. What can be the solution?  

3. Explain page number option. 

4. How templates can be useful to write an invitation of a 

birthday party to a friend? 

5. Anita has to prepare her assignment of mathematics. 

She is not able to type the expression . Suggest her the way to 

complete this. 

B. Fill in the Blanks. 

i. On selecting the image / shape _______ gets appeared. 

ii. Ctrl+P is used to take ________ of document. 

iii. Used characters in document are represented in _______ in special characters. 

iv. Formatting of image includes _____ of image. (insert / resize) 

v. Shapes are available in ________ menu. 

C. Match the following 

a) shapes and images can be p) Special characters 

b) Formula is available in q) save as template 

c) ¥ sign can be inserted through r) Print Preview 

Try Now- Give background colour to your page. Now give print command. How is your 

printout?  
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SOMETHING TO DO IN LAB 

1) Prepare a document. Insert at least three shapes and two images of your 

choice. 

2) Resize the image you have entered to larger size. 

3) Prepare a document and type features of writer. Insert page number in every 

page.  

4) Save the above document as template. 
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7. USE OF INTERNET 

7.1 History of Internet 

7.2 Intranet & Internet                                                                                                              

7.3 Requirement of Internet 

7.4 Application of Internet 

7.5 Downloading file from google drive  

7.6  Uploading file/folder to google Drive 

7.7 Blog 

 

 

Introduction  
  We live in the age of the internet. It has become popular and an 

important part of our life. The Internet was not invented overnight; it took a 

lot of time to work in this world. The internet is the integrated work of many 

scientists, programmers and engineers etc. 

 

7.1 History of Internet  

  

ARPANET stands for Advanced Research Projects Agency Network, 

experimental computer network that was the forerunner of the Internet. The 

Advanced Research Projects Agency (ARPA), an arm of the USA army gave the 

money to the development of the Advanced Research Projects Agency Network 

(ARPANET) in the late 1960s.  

 

1981: The National Science Foundation got a grant to establish the network 

among the university campus. 
 

1990: Tim Berners-Lee develops Hyper Text Markup Language (HTML).  
 

1991: European Council for Nuclear Research introduces the World Wide Web in 

public domain. 
 

1992: The first multimedia (audio & video) file is distributed over the Internet. 

The phrase "surfing the Internet" is popularized. 
 

2016: Google introduce Google Assistant, voice-based personal assistant 

software. Google introduce Amazon's Alexa, Siri from Apple, and Cortana from 

Microsoft. 
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7.2 Difference between internet and Intranet  

 

Internet: 

The Internet is used to connect different networks of computers simultaneously. 

It is a network and publicly anyone can access it. On the internet, there are 

multiple users and it provides an unlimited information to the users through 

sharing. 

 

Intranet: 

Intranet is the type of internet which is used privately. Intranet is a private 

network therefore all can’t access intranet. In intranet, there are a limited 

number of users and it provides a limited access to its users as it is administered 

by system admin. 

 

7.3 Requirement of Internet 

 

The requirement for connecting the Internet are computer/smart phone, 

an Internet line and the modem (inbuilt in mobile) for that Internet line. Other 

than these devices, software programs such as Internet browsers, email clients, 

Usenet clients and other special applications are needed in order to access the 

Internet. 

. 

 

 

 

 

 

 

 

Fig. 7.1: Requirements for Internet 

1. Computer : Machine used to send and receive electronic documents via internet 

2. Modem (Modulator & Demodulator): Device that transmits analog signal through 

telephone lines. 

3. Telephone lines/Cable Lines: used to transmit signals from one computer to 

another with the help of modem. 

4. Internet Service Provider (ISP): ISP provides an Internet connection e.g. MTNL, 

Airtel, Vodafone, Jio or any local broadband service provider. 

5. Web Browser: Software program used to navigate the Internet. e.g. Google 

Chrome, Microsoft Edge, Mozilla Firefox, Opera etc. 
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7.4 Application of Internet 
The internet is treated as one of the biggest inventions. It has a large 

number of uses. 

 

 
 

Fig. 7.2: Internet Applications 

 

1. Communication : 

Communication means to share the information, ideas, or simply words over the 

World Wide Web, or the Internet. 

2. Education :  

The Internet in Education has been incredibly useful as it facilitates both 

information and communication. Students can view free video lectures online and 

refer to encyclopedias and study material in multimedia formats; teachers can 

make their lessons interesting by incorporating online-based projects in their 

study plans. 

 

3. Business :  

Companies are collecting the information by tracking the browsing history of user 

and show various offers to customer. New and innovative online business models 

are coming. Everyone is searching for online business ideas. Persons are working 

from their home for companies around the world. Business information is faster 

than ever. The internet is the backbone of the online business. 
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4.  Entertainment : 

Entertainment is one other sector that has gained a lot from the internet. These 

days, more people consume most of their entertainment over the web rather 

than having to go to traditional entertainment avenues such as theatres. Movies, 

music and games etc. 

 

5. Medicine :  

Internet is also used for getting medicines online. We can order medicines by 

uploading the Doctor’s prescription and  may also get some discount over online 

medicine order. 

 

7.5 Downloading file from google drive  
 

Step 1: Log in on google your drive account by https://drive.google.com/ 

 

Step 2: Click a file to download. 

 

Step 3: Next right-click and click Download. 

 

 

 
 

Fig. 7.3: Uploading a file 

 

7.6  Uploading file to google Drive 
 

You may upload, view, share, and edit files with Google Drive. When you upload any 

file to Google Drive, it will take up space in your google Drive account, even if you 

upload to a folder owned by someone else. 
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Types of files 

Documents 

Images 

Audio 

Video 

Note: Maximum limit of upload data is 750GB a day as per based on your google 

account services. 

 

 

 

 

 

 

 

 

 

Fig. 7.4: Uploading file/folder to Google Drive 

Method 1:  

Step 1: Log in on your google drive account by https://drive.google.com/ 

Step 2: At the top left, click New and then File Upload or Folder Upload. 

Step 3: Choose the file or folder you want to upload. 

 

Method 2: 

Drag files into Google Drive 

Step 1: Log in on your google drive account by https://drive.google.com/ 

Step 2: Open or create a folder. 

Step 3: To upload files and folders directly, select file or folder from your 

system drag and drop into the Google Drive folder. 

7.7 Website Blogging 
Blog  

A blog is nothing but web site only which may be part of a website. Blogs are 

maintained by an individual or by group with entries of comments, 

descriptions of events, or other material such as images or video. Entries of 

blog displayed in reverse-chronological order.  

 

 

 

 

 

 

 

 

Fig. 7.5: Blog 
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 How to Make a Free Blog with WordPress?  

 

 The very first step you should take is to strategize a little about your blog: 

 

 What is it going to be about? 

 Who is your intended audience? 

 What type of content are you going to post? 

 These will lead you to other details. For example, are you going to post every 

day? If so, you should make sure your blogging system has good mobile 

support. You may need to update something on the go. 

 

Step 1: Select Start Your Website on the WordPress main page. 

 

Step 2: Sign up for a free WordPress.com account. You have to enter an email ID 

that hasn't been used for a WordPress account. 

https://wordpress.com/start/user 

 

Step 3: Pick a username in the second text box. This should be unique and suggestion 

also displayed. 

 

And choose a complex password that's difficult to break.  

 

After filling the details, click on Create your account. 

 

You can create blog fast by using your google/apple account by continuing . 

 

 

Fig. 7.6: Blog creation 
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Step 4: Now, you need to enter your blog information. Input interesting blog name 

for your blog in the first text box. This name of your blog is the attractive point of 

your blog. Make it reflect your blog interesting and unique. 

 

To answer What will your site be about, enter words or phrases separated by 

commas. For example, home, kids, family, travel etc. 

 

Step 5: Choose an address for your blog. Free WordPress blogs end with home. Blog, 

so the blog name you select precedes that URL and is what your viewers see when they 

visit on your blog. Enter whatever you want to use as your blog's URL.  After the 

search box many top-level domain names are given but you have to select only one. 

Select the free option domain name with the Select button, and then click Start with 

Free on the following page to see your new blog. 

 

After creation of your blog, it is verified by the email link that comes in your email by 

Blog website. Click on verify button, you will be greeted with a welcoming email and a 

few "getting started" steps WordPress recommends. 

 

The window you see below is the primary display where you work on your blog. This is 

place for manage your blog's pages, media, comments etc. 

Exercise 

Something to know 
A. Answer the following questions. 

1. What is ARPANET? 

2. Differentiate between Intranet & Internet. 

3. Write the requirements for the Internet. 

4. Write any two applications on the Internet. 

5. Why it is important to upload files on Google Drive. 
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B. Fill in the Blanks 

1. ARPANET was designed in late _____________year. 

2. ________________is the type of internet which is used privately. 

3. The Device convert Analog signals into digital & Vice versa is ________ 

4. ____________ provides the Internet connection to their Customer. 

5. ____________are usually maintained by an individual with regular entries. 

 

C. Match the Following: 

1. ISP a) Email, Video conferencing etc. 

2. Modem b) To download a file from  

Google drive to your system 

3. Downloading c) Internet Service Providers 

4. Application of Internet  d) Modulator and Demodulator 

D. Select the correct answer for each question : 

1.    ARPANET was  _____________________. 

(a)  School Group    (b) US defence project  (c) Google Project   (d) Science  
 

2. Entries are commonly displayed in reverse-chronological order called  

______________ 
 

(a) Google   (b) Microsoft    (c) Yahoo   (d) Blog 
           

3.  __________  is used to access websites and hypertext data.  
 

(a) ISP  (b) Web browser   (c)Webpage   (d) Email    
 

4. Which is not an application of the Internet? 

(a)  Physical Test  

(b)  Entertainment  

(c)  Business 

(d)  Communication  

 

E. State True  or  False  

1. By Video conferencing we can share Text, Voice and Video. 

2. The first audio and video are distributed over the Internet in 1992 

3. We cannot earn money by creating a blog. 

4. Modem is not essential for Internet connection. 

5. We can upload documents, Video, Audio files on Google Drive. 

 

SOMETHING TO DO 
1. Find the Intranet connection near you. 

2. Create a blog of your interest on wordpress.com and make it interacting. 
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APPENDIX 
ANSWERS 

 

Chapter 2 – Python Turtle 
 

A.  Answer the following questions: 

1. Canvas of Python turtle graphics means the screen of the Python turtle which 

is created for displaying the graphical images. 

2. We use  turtle to make shapes of various dimensions, colors and fills. 

3. We require to set up Python turtle screen so that a drawing area or canvas on 

computer is started where our figures will be drawn. 

4. Home position means the starting position of the turtle pen. It is the 

coordinate 0,0 in reference to the four quadrants that we have for the 

canvas. There are four quadrants in the Python turtle screen. 

5. We change the direction of turtle by using turtle.rt(n) , turtle.lt(n). 

 

B. Fill in the blanks: 

1. Four  

2. Program 

3. Points 

4. Classic 

5. left and right 

  

B. Match the following: 

A – 4 

B – 5 

C – 1 

D – 2 

E - 3 

  

D. Select the correct answer for each question: 

1. c. diameter 

2. b. bd()       

3. b. filled circle     

4. d. both a and c 

5. c. 10 

 

 E. State True or False.  

1. False. 

2. True 

3. False 

4. True 

5. True 
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Something to Do: 

1.   We can position the turtle to any x,y location. Use the following command to 

go to any coordinate wrt home. 

>>>turtle.goto(x,y) 

    e.g. turtle.goto(10,20) 

2.   Turtle.up() can be used to stop all drawing on the screen, cursor can still be 

placed at any location. Drawing will resume when you call turtle.down() again 

Turtle.clear() can be used to clear the entire screen area. Try it as the last 

command. 

 

Chapter 3 – Impress 

A. Answer the following questions  

1. Notes View can be used to write points. 

2. Slide pane shows thumbnail view of all slides along with normal view of selected 

slide. Whereas slide sorter view only shows thumbnails of all slides. 

3. Click insert on standard toolbar -> Audio or Video -> choose file. 

4. This happened because two images are grouped together. Select both, Click on 

format ->Group-> Ungroup. 

5. font, border, background etc 

B. Fill in the Blanks 

i. left, right  ii. Ungroup   iii. Split   iv. Normal    v. Slide show 

C. Match the following 

a) Audience cannot see s) Notes in slide 

b) Gradient is a part of r) Background of table 

c) holding shift key and clicking on shapes t) select all shapes together 

d) Best way to represent time table of anything  p) Tables 

e) Font effects in table properties q) applied over text in table 

 

D. Select the right option 

i.  d   ii.  d  iii.   a        iv.  d v.  b 

E. True/False 

a) False   b) True  c) True  d) False   e) False 

 

Chapter 4 – Calc 

 

1. False  

2.  True 

3. True 

 4. False 

 5. True 
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II Format cells    Ctrl+1 

     Insert cells    Ctrl++ 

     Clear cells    Backspace 

     Delete cells    Ctrl+- 

     Data    Sort 

 

III 1. Sort  

    2. AutoFilter 

    3.  Show sheet 

     4. Sheet 

     5. Format 

IV 1. AutoFilter 

     2. Sort descending 

     3. Merge cells 

     4.  Select Sheet-> Insert sheet at the end    

      5. Format Menu 

 

Chapter 5 

A.Answer in one word or one line. 

1.Abacus 

2.Second Generation 

3. Electronic Numerical Integrator And Computer 

4. Fifth Generation 

5. Charles Babbage 

 

B. Fill in the Blanks 

1. Assembly 

2. fourth 

3. IBM 

4. John Napier 

5. MARK-1. 

 

C. Match the Following. 

1-b, 2-d, 3-e, 4-c, 5-a 

 

D. State True  or  False  

1. True 

2. False 

3. True 

4. False 

5. true 
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Chapter 6 – Writer 

A. Answer the following questions  

1. It saves time, it gives an idea to create a document or any two 

2. Select the image. Click on rotate and Rotate the image. 

3. This is used to insert page number anywhere in the document. 

4. Use the template of invitation. Just write your friend’s detail and party details 

and use. 

5. Use insert->objects->formulas 

B. Fill in the Blanks 

i. Selection handle,  ii. print,  iii. favourite characters  iv. resize  v. 

insert  

C. Match the following 

a) shapes and images can be p) rotate and resize  

b) Formula is available in q) Objects option 

c) ¥ sign can be inserted through r) Special characters 

d) to make your current document as sample 

for future  

s) save as template 

e) to see how document will look after 

printing  

t) Print Preview 

 

D. Select the right option 

i. d   ii.  a   iii.  c iv. b      v. d 

E. True/False 

a) False  b) False c) True  d) True  e) True 

 

Chapter 7 

A: 

1. Ans.  ARPANET, in full Advanced Research Projects Agency Network, 

experimental computer network that was the forerunner of the Internet. The 

Advanced Research Projects Agency (ARPA), an arm of the U.S. Defense 

Department, funded the development of the Advanced Research Projects 

Agency Network (ARPANET) in the late 1960s. 

 

2. Ans.   

Internet: 
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The Internet is used to connect different networks of computers 

simultaneously. It is a public network therefore anyone can access the internet. 

On the internet, there are multiple users and it provides an unlimited number 

of information to the users. 

 

Intranet: 

Intranet is the type of internet which is used privately. It is a private 

network therefore anyone can’t access intranet. In intranet, there are a limited 

number of users and it provides a limited number of information to its users. 

 

3. Ans. To connect to the Internet you need the following four things: 

(i) A computer 

(ii) A modem and telephone line (if you are using dial up access) 

(iii) A data line of some sort (if you are not using dial up access) 

(iv)An Internet browser (software) and software to connect you to the 

ISP 

(v) An account with an Internet Service Provider (ISP) Souvenirs 

 

4. Ans. The Internet has many important applications. Of the various services 

available via the Internet, the three most important are e-mail, web browsing, 

and peer-to-peer services.  

 (i) Education    (ii) Entertainment 

 

5. Ans.  It is important to keep files on Google drive because it provides backup 

of our file if deleted , Protect Against Hackers and Malware. It's Easier to 

Share and Access Files. 

 

B. Fill in the Blanks 

1. 1960 

2. Intranet 

3. Modem 

4. ISP 

5. Blogs 

C. Match the Following. 

1 ---- c 

2 ---- d 

3 ---- b 

4 ---- a 

 

D. Select the correct answer for each question. 

1. B 

2. D 

3. B 
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4. A 

 

E. State True  or  False  

1. True 

2. True 

3. False 

4. False 

5. True 
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